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Premiere Elements 2021.1 Slideshow Workshop 

Created and Presented by Barry Headrick 

February 13, 2021 

 

Welcome to the Adobe Premiere Elements 2021.1 (aka version 19.0) slideshow workshop! 

This workshop is based on Windows. Mac users will have some differences in shortcut keys. 

Demo Slideshow 

For your reference, I created six mp4 files with different resolutions and bit rates (Quality 

Settings).  These files are all from the same Adobe Premiere Elements (PREL) project.  They are 

all 3 minutes and 19 seconds in length. They are in my DropBox account for you to view and 

download.  The link to my DropBox folder is  

https://www.dropbox.com/sh/4ior8jrhqtnb0mk/AADj-1jINcDrQ0DDMyQoRfJXa?dl=0 . 

PREL 
Export 
Preset 

Common 
Name 

Resolution 
(Frame Size) 

in pixels 
Quality Setting (Bitrate) File Size 

4k UltraHD 
UHD or 4K 

or Quad HD 
3850 by 2160 High 2,358 MB 

4k UltraHD 
UHD or 4K 

or Quad HD 
3850 by 2160 Medium (recommended) 1,464 MB 

4k UltraHD 
UHD or 4K 

or Quad HD 
3850 by 2160 Low 1,102 MB 

HD 1080 Full HD 1920 by 1080 Medium (recommended) 503 MB 

HD 720 HD 1280 by 720 Medium (recommended) 225 MB 

SD 480 
NTSC SD 

(Standard 
Definition ) 

720 by 480 Medium (recommended) 134 MB 

 

 

 

https://www.dropbox.com/sh/4ior8jrhqtnb0mk/AADj-1jINcDrQ0DDMyQoRfJXa?dl=0
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My Workflow to Create a  Slide Show in Premiere Elements Expert View 

1. Create a folder for your project on your fastest drive which is not the system drive. 

2. Create an Images folder in your project folder.  This will hold all your jpeg, raw, PSD, etc. 

3. Create an Audio folder in your project folder.  This will hold all your music, sound effects, 

narration, etc. 

4. Choose the images for your slide show.  I usually choose more than I will need to allow for 

adding some more while I am creating the slide show.  Around 20 to 40 images is good. 

5. Use an app like Lightroom to create a collection of your images in the desired sequence.  

6. Export your images to the images folder in your project folder.  Use file names that begin 

with a sequence number.  Number your images starting at 100 and incrementing by 100, 

such as 00100, 00200, 00300, etc.  Later, if needed, you can insert additional images in 

ascending file number sequence such as 00550.   If you prefer, you can add images to your 

project from any folder on any drive on your computer.  Or you can use the Elements 

Organizer to sort and select your images for your slide show. 

7. Get your music tracks and sound effects.  You can use PREL’s built-in music tracks. 

I use Audio Jungle.  https://audiojungle.net/.  This site has no royalties, no membership 

fees, no subscription fees, and they accept PayPal.  You can use their royalty free tracks on 

all social web sites.  They will send you a PDF license document for your purchases.  You 

can download their preview tracks with a voiceover for free to test with your project.  

Many purchases come with the track remixed to different lengths.  Make sure that the 

longest track of the music is long enough.  Prices usually vary from $1 US to around $30 

US.  Finding the right music can be the hardest part of creating your slideshow.  My search 

in AudioJungle for the term “tropical party” returned 9,543 items (see below).  

 

https://audiojungle.net/
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CAUTION:  do not use copyrighted (protected) music such as iTunes in social media sites 

such as YouTube and Facebook.  You can include copyrighted (protected) tracks in your 

project but be careful where you post them. 

8. If you are going to include narration in your project, write the script and find your narrator 

(person speaking).  You can record the narration clip(s) in PREL or you can use an audio 

recording app to create your audio clip(s) and then import them into your project. 

9. Open PREL and create a new project (File → New Project) in your project folder.  Be sure 

to use the Project Configuration Settings and Preferences that are described below. 

10. Select the Expert view timeline. 

 

11. Drag and drop your images (in the sequence that you want them in) from File Explorer 

onto your timeline.  Use the Video 1 track in the timeline.  This will also add your images 

to the Project Assets window. 

12. Adjust the length of each image.  You can set the length of multiple images at one time.  

Five seconds is the PREL default.  Most slide shows use around 5 to 8 seconds per image. 

13. Create the beginning and ending slides if desired.  For example, create a title slide at the 

beginning and a rolling credits slide at the end. 

14. Add your music files.  You can drag and drop your audio files from File Explorer into the 

timeline.  If you have only one music file, add it to the Music track on the timeline so that 

you can resample the music to match the length of your slideshow.  If you have multiple 

music files, trim them to match the length of the slideshow. 

15. If you are going to change the sequence of the images on the timeline, now is the best 

time to do this before transitions and captions are added to the timeline.  I have already 

added the music track(s) at this time so that I can change the sequence of the images in 

the timeline to ensure that the music matches up with the images as much as possible. 

16. Add transitions between the images. 

17. Add your sound effects and narration track(s) to align with the images that they belong to.  

Add your sound effects to any audio track.  Add your narration track(s) to the Voice track. 

18. Add your pan and zoom (Ken Burns effect) effects.  Add any other effects that you want. 

19. Create your captions and add them to a video track that is above your images.  Create a 

caption (title) slide that you like and duplicate it in the titles folder in Project Assets panel. 

20. Play your slideshow in PREL and adjust as needed.  This can be a very long process. 

21. Export your project as an MP4 file in the desired resolution.  Use the medium quality 

setting in most cases.  You can also try the high quality setting if the file size is not too 

large.  The difference between these quality settings is the bitrate. 
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Project Configuration (Settings and Preferences) 

When you create a new project (File → New Project), give the new project a name, specify 

your project folder as the “Save In:” location, and click Change Settings.  Select the Force 

Selected Project Setting on this Project check box.  Be sure to select the 4k 29.97 frames per 

second option as shown below.  You cannot change this setting for an existing project. 

 

 

Confirm your project settings in the Project Settings panel as shown below before you proceed 

with your project.  If these settings are wrong, you have to start over with the right settings. 
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Choose your preferences as shown below.  If you are going to apply pan and zoom to all (or 

most) of your images, uncheck the Default Scale to Frame Size option.  Otherwise leave it 

checked so that each slide will be automatically resized to fit the frame size that you selected 
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(3840 by 2160 pixels for a 4k project).  Select your Still Image Default Duration if you don’t 

want to use the default 5 second duration. 

3 
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Reasons for choosing Adobe Premiere Elements (PREL) as your Slideshow App 

PREL is from by a large successful company.  It is not likely to suddenly go out of business.  I 

used Proshow Gold and Proshow Producer for many years (decades?) until Photodex suddenly 

went out of business in January 2020.  Their Proshow products are now unsupported. 

PREL has a perpetual license not a subscription.  It is $99 U.S. for Premier Elements, or $149 

U.S. for the Premiere Elements and Photoshop Elements bundle.  The 2021.1 version is 

available now.  https://www.adobe.com/ca/products/photoshop-premiere-elements.html  

There is a discount for the upgrade if you own a previous version. 

There is a 30 day free trial https://www.adobe.com/ca/products/photoshop-

elements/download-trial/try.html You have to create an Adobe account if you don’t have one. 

If you have a video clip or two that you want to include in your slideshow, PREL can easily do 

this.  Some dedicated slideshow apps cannot include video files. 

PREL is rated as 3.5 out of 5 stars by PC magazine https://www.pcmag.com/reviews/adobe-

premiere-elements.  The PC Magazine review was updated on November 4, 2020 for PREL 

version 2021.  It is definitely worth a quick read if you are considering this product, or if you 

have an older version of PREL.  From PC magazine: 

PROS 

• Clear, simple interface 

• Guided Edits ease basic and advanced projects 

• Lots of video effects 

• Solid text tools 

• Cross-platform support 

CONS 

• Slow output rendering speed 

• No 360-degree VR or 3D editing 

• No multicam support 

Here are some other video editor reviews for your reference: 

https://www.creativebloq.com/features/best-video-editing-software-for-designers 

https://www.techradar.com/best/free-video-editing-software 

PREL projects can be opened and edited in Adobe Premiere Pro, which is rated at the best 

professional video editor by some reviewers https://www.pcmag.com/reviews/adobe-

premiere-pro-cc  https://www.pcmag.com/picks/the-best-video-editing-software 

https://www.adobe.com/ca/products/photoshop-premiere-elements.html
https://www.adobe.com/ca/products/photoshop-elements/download-trial/try.html
https://www.adobe.com/ca/products/photoshop-elements/download-trial/try.html
https://www.pcmag.com/reviews/adobe-premiere-elements
https://www.pcmag.com/reviews/adobe-premiere-elements
https://www.creativebloq.com/features/best-video-editing-software-for-designers
https://www.techradar.com/best/free-video-editing-software
https://www.pcmag.com/reviews/adobe-premiere-pro-cc
https://www.pcmag.com/reviews/adobe-premiere-pro-cc
https://www.pcmag.com/picks/the-best-video-editing-software
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There are 103 transitions in PREL 2021 and some cool special effects. 

There is a free online video course from the Edmonton Public Library.  The course is from 

LinkedIn (formerly Lynda).  The course runs for 3 hours 17 minutes. I did not see any free 

training for any other slideshow app.  https://www.lynda.com/Premiere-Elements-

tutorials/Learning-Premiere-Elements-2021/2864009-

2.html?srchtrk=index%3a7%0alinktypeid%3a2%0aq%3avideo+editing+premiere+elements%0a

page%3a1%0as%3arelevance%0asa%3atrue%0aproducttypeid%3a2 

There are 8 YouTube videos from an independent instructor for new users of PREL 

https://www.youtube.com/watch?v=4t5irSeJgyg&t=23s 

PREL can import and edit raw files.  It uses the same raw converter as other Adobe products 

like Lightroom and Photoshop and Adobe Camera Raw. 

PREL can import PSD files from Photoshop.  You can create an image in Photoshop with text 

and other features and import it directly into PREL (no need for a JPEG file).  You can create a 

rolling closing credit slide.  The closing credit slide should have a black background to match 

the slide show background colour.  Or you can create a slide with a white background with lots 

of blank space at the top and bottom for your transition to this slide.  All vector graphics in the 

PSD file such as text and smart image layers will resize smoothly for playback at any chosen 

resolution.  

PREL can create chroma key effects with your still image, with a still or moving background.  

Maybe it is time to buy a green screen backdrop?  Prices currently range from $53 to $850 at 

Vistek https://www.vistek.ca/search/?q=green%20screen%20backdrop 

There are a few different options in PREL, the Elements hub, and the Elements organizer to 

create slide shows with varying levels of automation and control. 

1. You can create a slide show in the organizer. 

 

Alternately  you can select multiple images in the organizer (control-click each image) and 

then right-click and choose Create Slideshow.  The slideshows are created automatically 

with a music track with very little user input. 

  

https://www.lynda.com/Premiere-Elements-tutorials/Learning-Premiere-Elements-2021/2864009-2.html?srchtrk=index%3a7%0alinktypeid%3a2%0aq%3avideo+editing+premiere+elements%0apage%3a1%0as%3arelevance%0asa%3atrue%0aproducttypeid%3a2
https://www.lynda.com/Premiere-Elements-tutorials/Learning-Premiere-Elements-2021/2864009-2.html?srchtrk=index%3a7%0alinktypeid%3a2%0aq%3avideo+editing+premiere+elements%0apage%3a1%0as%3arelevance%0asa%3atrue%0aproducttypeid%3a2
https://www.lynda.com/Premiere-Elements-tutorials/Learning-Premiere-Elements-2021/2864009-2.html?srchtrk=index%3a7%0alinktypeid%3a2%0aq%3avideo+editing+premiere+elements%0apage%3a1%0as%3arelevance%0asa%3atrue%0aproducttypeid%3a2
https://www.lynda.com/Premiere-Elements-tutorials/Learning-Premiere-Elements-2021/2864009-2.html?srchtrk=index%3a7%0alinktypeid%3a2%0aq%3avideo+editing+premiere+elements%0apage%3a1%0as%3arelevance%0asa%3atrue%0aproducttypeid%3a2
https://www.youtube.com/watch?v=4t5irSeJgyg&t=23s
https://www.vistek.ca/search/?q=green%20screen%20backdrop
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2. You can create a slide show in the hub. 

 

3. You can create an Instant Movie with a Slideshow Theme 

 

4. You can create an Slide Show in the Project Assets panel 



Premiere Elements 2021.1 February 13, 2021 Page 10 of 15 

5.  You can create a slide show in Quick View timeline 

 

6. You can create a slide show in Expert View timeline. 

 

The Expert view is the only option that gives you all of the features and control in PREL. 

PREL includes several music tracks that can be resampled to match the exact length of your 

slide show.  The music tracks must be placed on the Music track, not an Audio track. 

PREL includes a file organizer that works with Premiere Elements and Photoshop Elements. 

PREL supports up to C4K (4096 by 2160 pixel) and 4K (3840 by 2160 pixel) video input and up 

to 4K for output.  Your still images (jpeg, tiff, DNG, raw, etc.) can be any pixel dimensions.  

Output formats include SD, HD, Full HD, 4K, DVD (SD resolution), BluRay (HD resolution), 

mobile, tablet, and various social media.  You can input but not output HEVC and HEIC format 

video and still images.  You can adjust the output file bitrate with a custom export profile to 

get the best compromise between image quality and file size. 

The PREL 2021 book from an independent author is available for $61 CDN 

https://www.amazon.ca/s?k=premiere+elements+2021&ref=nb_sb_noss_1 

A new version of PREL has been released every year since 2004.  There is a cost to upgrade to 

new major versions.  I received a free upgrade to PREL version 2021.1 on February 4, 2021. 

  

https://www.amazon.ca/s?k=premiere+elements+2021&ref=nb_sb_noss_1
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Installation 

When you download and install PREL, you get three apps: the Hub, the Organizer, and the 

Premiere Elements editor. 

I recommend that you pin the Hub, Organizer, and Premiere Elements to your taskbar for 

quick access to whichever app you want to use. 

 

 

How many computers can I install PREL on with one licence? 

You can install your product on up to two computers. If you want to move your product to a 

new computer, simply choose Help > Sign Out in the product from one of the computers that 

has an active license. You can then install the product on your new computer.  

https://www.adobe.com/ca/products/premiere-

elements/faq.html#:~:text=May%20I%20install%20Premiere%20Elements,product%20on%20y

our%20new%20computer 

  

https://www.adobe.com/ca/products/premiere-elements/faq.html#:~:text=May%20I%20install%20Premiere%20Elements,product%20on%20your%20new%20computer
https://www.adobe.com/ca/products/premiere-elements/faq.html#:~:text=May%20I%20install%20Premiere%20Elements,product%20on%20your%20new%20computer
https://www.adobe.com/ca/products/premiere-elements/faq.html#:~:text=May%20I%20install%20Premiere%20Elements,product%20on%20your%20new%20computer
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Tips 

Tip number 1: Important: make frequent copies of your PREL file while you are editing.  Close 

PREL and copy the project file, preferably to another hard drive, then reopen PREL. 

Tip number 2: use the Project Archiver (File → Project Archiver) to back up your PREL file and 

all input files to another drive. 
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Tip Number 3: my favorite transitions (use the search box at the top of the transitions panel to 

find them) are Cross Dissolve, Film Dissolve, Curtain, Iris Star, Doors, Magic Carpet, Wave, 

Sliding Bands, Venetian Blinds, and Random Wipe.  Your images might work better with 

others.  Test them all.  There are over 100 transitions. 

Tip number 4: use the same typeface, size, colour, stroke, drop shadow, and placement for all 

of the captions in your project. 

Tip number 5: keep the captions brief and informative.  Do not state the obvious in your 

captions such as “this is a horse”. 

Tip number 6: when you have a caption (title slide) that you are happy with, you can export it 

and use it in other projects. 

 

Tip number 7: when you start to use PREL, you will spend hours if not days, exploring the 

various transitions and special effects and built-in music tracks and other features.  Plan some 

time for this.  Keep an eye on the clock or you could work through the entire night. 

Tip number 8 (Windows only): hold down the ALT key to prevent rippling when moving things 

around on the timeline. 

Tip number 9: your most used shortcut keys will probably be: \ (backslash) (resize the timeline 

to screen width), + (plus) (zoom in to the timeline, and – (minus) (zoom out of the timeline) 
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Tip number 10: this applies to slides that have keyframes for any effect such as pan and zoom, 

etc.  If you change the length of the slide or add transitions, go back and check the position of 

the keyframes.  If you shorten a slide, you may have to delete and then recreate the 

keyframes. 

 

Recent Updates for PREL (free updates) 

Photoshop Camera Raw 13.0 update 

Released: November 25, 2020 

A new update to the Camera Raw plug-in is available, contains added raw support for newer 

camera models. 

For detailed information about this update, see the article on  

https://helpx.adobe.com/ca/camera-raw/using/supported-cameras.html. 

PREL Version 2021.1 

Released: February 3, 2021. 

 

  

https://helpx.adobe.com/ca/camera-raw/using/supported-cameras.html
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Output File Timing Tests Conducted on February 5 - 6, 2021 

This video runs for 3 minutes and 19 seconds. 

Video file number 1: 4K high quality (high bitrate), 3840 by 2160 pixels, mp4, H.264 

Video file number 2: SD medium quality (medium bitrate), 720 by 480 pixels, mp4, H.264 

Computer number 1:  desktop with an i9 processor with 8 cores, running at 4.69 GHz, 64GB of 

RAM, and two 1 TB SSDs. 

Computer number 2: laptop with an i7 processor with 6 cores, running at 2.5 – 3.0 GHz, 16 GB 

of RAM, 1 SSD for the OS and apps and one hard drive for the data. 

Computer Output File Export Time File Size 

1 (Desktop) 4k High Quality 7 minutes 42 seconds 2,294 MB 

1 (Desktop) SD Medium Quality 33 seconds 130 MB 

2 (Laptop) 4k High Quality 15 minutes 43 seconds 2,368 MB 

2 (Laptop) SD Medium Quality 1 minute 40 seconds 131 MB 

 


